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Important
The following functions are for reference only. Some series products may not
support all the functions listed below.
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1 Network Config

1.1 Network Connection

Network camera and PC connection mainly has two ways, see Figure 1-1 and Figure 1-2.

Cable

/ Oor & g
™ . >

Network Camera

Cible~ ¥
o Switch or Router
/ Or —
V”'
V. 'w

Netwrok Camera

Figure 1-2

Before you access network camera via the Internet, you need to have its IP address. User can use
quick config tool to search IP of the network camera. Please refer to Quick Configuration Tool manual.

1.2 Login

Open IE and input network camera address in the address bar.

For example, if your camera IP is 192.168.1.108, then please input http:// 192.168.1.108 in IE address
bar.

The login interface is shown as below. See Figure 1-3.

Please input your user name and password.

Default factory username is admin and password is admin.

Note: For security reasons, please modify your password after you first login.
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Username: ||

Passwaord:

Figure 1-3

If it is your first time to login in, you may see the interface shown as in Figure 1-4.

@lhua

Main Stream Protocol SR

@ Please click here to download and install the plug-in.

X3 to L B

Figure 1-4
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Click on “Please click here to download and install the plug-in”. The system pops up warning information
to ask you whether run or save this plug-in. See Figure 1-5.

Do you want to run or save this file?

Mame: webplugin.exe
Type: Application, 1.05MB

From: 10.10.4.198

Run JI Save ]L Canicel ]

= Whilz files from the [nternet can be uzeful, thiz file tvpe can
[ g :
B potentially harm your computer. |F pou do not trust the source, do not
"2 un or zave this software. What's the risk?

Figure 1-5

You must either run or save the file to local and install it. Follow the following steps. Click on run, you
will see Figure 1-6 and Figure 1-7.
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Ready to Install
Setup is now ready to begin instaling webplugin.exe on your computer,

Click Install to continue with the installation,

[ Install ][ Cancel

Figure 1-6

Installing
Please wait while Setup nstalls webplugin,exe on your computer,

Reqgistering files...

Cancel
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Figure 1-7

When plug-in installation completes, the installation page closes automatically. The web-end will
refresh automatically, and then you can view video captured by the camera. See Figure 1-8.

Protoco! TS CErle 1-k=1 1¢)

2015-09-25 14:40:57 Eri

Min:1 1.4

Figure 1-8
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2 Live

After you logged in, you can see the live monitor window. See Figure 2-1.

BT ~rotoco! REEY e R =L X0

2015-09-25 14:42:14 FEri

Min: 1 1.4

y $o au B
Figure 2-1

There are four sections:

® Section 1: Encode setup bar

® Section 2: System menu

® Section 3: Window function option bar
® Section 4: Window adjust bar

2.1 Encode Setup

The encode setup interface is shown as in Figure 2-2.

Protocol u
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Figure 2-2
Please refer to the following sheet for detailed information.
Parameter Function
Main stream Streaming media protocol connection, under main stream config,

monitor video or not. Generally for storage and monitor.

Sub (Extra)

Streaming media protocol connection, under sub stream config,
monitor video or not. When network bandwidth is insufficient, it

stream : : o
substitutes main stream for monitoring.
Protocol You can select stream media protocol from the dropdown list.
There are three options: TCP/UDP/Multicast
2.2 System Menu

System menu is shown as in Figure 2-3.
Please refer to chapter 2 Live, chapter 3 Playback, chapter 4 Setup, chapter 5 Alarm, chapter 6 Log out,

for detailed information.

Live

Playback Setup Alarm Logout

Figure 2-3

2.3 Video Window Function Option

The interface is shown as below. See Figure 2-4.

L@ @ @ 8 ® @

Figure 2-4
Please refer to the following sheet for detailed information.
SN Parameter Function
1 Alarm It shows if there is any alarm output, status description is as
output follows:

® Red: means there is alarm output.
® Grey: means alarm is over.
Click on the button to force alarm to be on or off.
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2 Zoom in ® When the video is in the (_)riginal status, c_quk it you can
select any zone to zoom in. In the non-original status,
you can drag the zoom-in zone in specified range. Right
click mouse to restore previous status.

® Click it; you can use the middle button of the mouse to
zoom in/out the video size.

3 Snapshot Click on the button to snapshot, save picture to path in Ch

5.1.2.5.

4 Triple snap _Click it, system can snap at 1f/s. All images are saved to path

in Ch5.1.2.5.

5 Record Click it, system can record. All images are saved to path in Ch

5.1.2.5.

6 Audio Turn pn or off audio when you are monitoring.

output Note: o .
Only supported by the device with audio.
7 Help Click it to open help file.

2.4 Video Window Setup

The interface is shown as in Figure 2-5.

W l00% B3

D200 @O

Figure 2-5

2.4.1 Image Adjustment
See Figure 2-6 for image adjustment.
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Image Adjustment

Figure 2-6

Click this button to display/hide image control interface. Click it to open picture setup interface. This
interface is on the top right pane.

Please refer to the following sheet for detailed information.

Parameter Function

Video It is to adjust monitor video Note:

setup brightness. ® All the operations here apply
to WEB end only.

® Please go to Setup-

m It is to adjust monitor video

conrasiness. >Camera->Conditions to
a It is to adjust monitor video adjust corresponding items.
hue.

E It is to adjust monitor video
saturation.

Reset | Restore brightness,
contrastness saturation and
hue to system default setup.

2.4.2 Original Size
Click this button to go to original size. It is to display the actual size of the video stream. It depends on
the resolution of the bit stream.

2.4.3 Full Screen
Click it to go to full-screen mode. Double click the mouse or click the Esc button to exit the full screen.
9
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2.4.4 Width and Height Ratio
Click it to restore original ratio or suitable window.

2.4.5 Fluency Adjustment
There are three levels of fluency for you to select (real-time, normal, fluent). The default is normal.

2.4.6 Rules Info

Click it to enable preview page to display intelligent rules, the default is on.

Note:

The function is only supported by some devices.

2.4.7 Realtime Report

It is to open or close temperature record interface, it mainly records the temperature change of selected
spot, line and area within designated time period starting from the current time. See Figure 2-7.

Note:

The function is only supported by some devices.

2.4.8 Ray Axis Correct

It is to enable or disable ray axis correct.

Note:

The function is only supported by some devices.

10
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Figure 2-7

11
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3 Playback

Web client playback supports video playback and picture playback.
Note:
Before playback, user shall set storage management as in Ch 5.5.

3.1 Playback

The playback interface is shown as in Figure 3-1.

TP Camera

e Tipe

54N Mon Toe Wed Tha Fri S

oo0cQ®0 ©

Receed Typo B 2

Figure 3-1

There are four sections:

Section 1: Function of play
Section 2: Playback file
Section 3: Play time cut
Section 4: Record type
Section 5: Progress bar
Section 6: Assistant function

3.1.1 Function of Play
The function of play is shown as in Figure 3-2.

12
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OC00DO O

@ 6 @& 6 0

Figure 3-2
Parameter Function
@ Pl When you see this button, it means pause or not played record. Click on this
ay .
button, switch to normal play status.
@ Stop Click this button to stop playing.
Click on this button to go to next frame.
® Play by Note:
frame '
You shall pause record when you use this function.
@ Slow Click on this button to play slowly.
® Quick Click on this button to play quickly.
. When this button displays, it means audio is silent. Click on this button to switch
® Silent
back to normal.
@ Volume Click on left mouse to adjust volume.

3.1.2 Playback File
In calendar, blue date represents data currently has video record or snapshot. See Figure 3-3.

13
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Data Src  RIEEET) 7
< 2013 I8

Sun Mon Tue Wed Thu Fri Sat

Parameter Function

e Select “dav”, as video playback.

File Type
yp e Select “jpg” as picture playback.

Data Source Default is SD card.

Step 1. Click on data in blue, time axis displays record file progress bar in color. While, green represents
normal record, yellow represents motion detect record, red represents alarm record, and blue
represents manual record.

Step 2. Click on certain time on progress bar, playback starts from this time. See Figure 3-4.

Figure 3-4

Step 3. Click on file list = , select date file will be displayed in list.

Step 4. Double click on file in list, playback this file and display file size, start time and end time.
See Figure 3-5.

14
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00 : 00 : 00 - 23 - 59 - 59 jKe}

DownlLoad Format ®dav 9 mp4d

Start Time  File Type
|

13:04:22
13:04:58
131208
13:21:22
132244
132412
132432
13:38:22
13:4518

EE EEEEEEESN
(el e NeNeleReleRele e

14:40:14

<11 vi[D

Begin Time: 2013-12-18 13:03:20

End Time: 2013-12-18 13:03:55

File Size:

Parameter Function

BSearch It means records within searched start time and end time on the date.
Record

Download There are two formats: dav, mp4.

Format

15



@hua

Parameter Function

Dahua IR Thermal Imaging Network Camera Web3.0 Operation Manual

e Record type is “dav”, click on download button to download file to local.
e Record type is “mp4”, click on download button and download file to path in

mDownIoad Ch5.125.
Note:

System does not support download and playback of MP4 file.

€« Back Click on back button to go to calendar interface.

3.1.3 Playback Cut

Note:

Playback cut function will automatically pause playing record as playback cut and playback cannot be at
the same time.

Step 1. Click on start time to cut on time axis. This time must be within progress bar range.

—_—

Step 2. Move mouse to cut icon 5;5 . You will be ask to select start time. Click on cur icon 5’5 as

finish cutting.
Step 3. Click on playback cut end time on time axis. This time must be within progress bar range.

—_— _—

Step 4. Move mouse to cut icon 5;5 , you will be asked to select end time. Click on cut icon 5:5 as

finish cutting.
Step 5. Click on Save button to save file cut to path in Ch 5.1.2.5. See Figure 3-6.

00:00:00-00:00:00 m

Figure 3-6

3.1.4 Record Type
Check record file type, only selected file will be displayed in progress bar and file list. See Figure 3-7.

Record Type All General Motion Alarm Manual Il

Figure 3-7

16
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3.1.5 Progress Bar

O zhr O nr | O 30min

Figure 3-8
Parameter Function
O z4hr 24 hours Click on it, means video in past 24 hours.
©zhr |, hours Click on it, means video in past 2 hours.
Oihr |, hour Click on it, means video in past 1 hour.
®:z0min 30 min Click on it, means video in past 30 min.

3.1.6 Assistant Function
Video playback assistant function is shown in Figure 3-9.

Figure 3-9

Parameter

Function

2 Zoom in

e Click on it, video in playback status if is in original size, user can
zoom in any area, If it is not in its original size, click on mouse to
restore its original size.

e Click on this button, you can scroll to zoom in.

E] Snapshot

Click on this button, you can snapshot video under playback status.
Snapshot will be saved to path in Ch 5.1.2.5.

3.2 Picture Playback

Web client picture playback interface has the following three functions:

Parameter Function

1 Play function bar

2 Playback file bar

17
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|3 | Snapshot type bar

See Figure 3-10.

@

Data Src SD Card v

< NEE >

Sun Mon Tue Wed Thu Fri Sat

11213]4]5
6j7|8jojofj11]12
13 14 15 16 17 18 19

20| 21| 22| 23 | 24 [25] 26

27 /2829 30

[>)

Snapshot Type All General M Motion M Alarm

Figure 3-10

oo

Figure 3-11

3.2.1 Play

Default icon is E and it means pause or not played picture. Click on play button to switch to

normal play status. Icon become m

® Click on it to pause.
3.2.2 Playback File

18
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< 2013 S

Sun Mon Tue Wed Thu Fri Sat

Figure 3-12

Step 1. Click on file list = , select snapshot file of the date.

Step 2. Double click on file in list, to play this snapshot.

Parameter

Function

n Search

It means all snapshot files within the start time and end time of selected date.

19



@hua

Dahua IR Thermal Imaging Network Camera Web3.0 Operation Manual

Parameter Function
EDownload Click on download button to download snapshot file to local.
& Back Click on back button to return to calendar interface and re-select time.

00 - 00 : 00 - 23 59 - 59 jKke}

Start Time  File Type
13:03:40 |
13:03:41
13:03:42
13:03:43
13:03:44
13:03:45

|

|

|

|

|
13:04:42 |
13:04:43 |
|

|

|

|

|

g

13:04:44
13:04:45
13:04:46
13:04:47
13:04:48

i0000000000000

M «1/8 p

Figure 3-13

3.2.3 Snapshot Type
Check snapshot file type, in file list only display file of selected type. See Figure 3-14.

20
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Snapshot Type All General Motion I Alarm

Figure 3-14

21
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4 Report

Attention:
Currently only some models support report function.

The WEB client supports temperature data query of the spot, line and area set by users. Please refer to

“5.4.1 Rule Setup” of the settings for spot, line and area.

Search

Search Time 2015 - 09 - 24

Period 10

Type I Spot[] Line [ Area

()

Figure 4-1

Set query condition, click “Search” to check the temperature data within the time period, see Figure 4-2.

22
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Search
Search Time 2015 -
15
to
2015 -
15
Period 10
Type I Spot

09 -

09

Li

ne Area

History Report

1001
20 -
20 -
70+
60 -
50 -
40+
30 -
20 -

10

17:.09:00
2015-9-24 ~ 2015-8-25

19:08:00
1i3(Page)

21:09:00

Figure 4-2

23.09:00

Hour

23
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5 Setup

Web client setup support camera, network, event, storage, system and system info view.
5.1 Camera
5.1.1 Conditions

Here you can view device property information. Slight differences may be found due to different network
camera series. The setups become valid immediately after you set. See Figure 5-1.

Conditions

> Video i
&=
> Audio O

Network M Lete camma () —) S
Event o Ezoom O @F—————B0
Temperature i ' Smart Scene {5{(3) —{J)————————@ 15
Storage Colorization | White Hot v
System ROIType | Custom v
Information Wirror ON ® OFF

Flip 0° ¥

Motion Detection Area to have automatic ROl match Use Custom ROI.

Advanced Settings|

[ ndoor ][ outdoor ][ _ General

DEVICE INFORMATION
SERIAL NUMBER: 47859
SOFTWARE VERSION:  15.20.15.16
FIRMWARE VERSION:  15.13.14.13

LIBRARY VERSION: E3.00.05

Figure 5-1

Able to set indoor scene, outdoor scene, general scene, you can set and check the config and effect in

the corresponding scene after selecting needed scene, please refer to the following sheet for the exact
parameters.

24
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Parameter

Function

Brightness

It is to adjust monitor window brightness. You can adjust this
value if the video is too dark or too bright. The larger the
number, the bright the video is. When you input the value here,
the bright section and the dark section of the video will be
adjusted accordingly. Please note the video may become hazy
if the value is too high.

The value ranges from 0 to 100. The recommended value
ranges from 40 to 60. The default value is 50.

Sharpness

The value here is to adjust the edge of the video. The larger
the value is, the clear the edge is and vice versa. Please note
there is noise if the value here is too high.

The value ranges from 0 to 100. The recommended value
ranges from 5 to 50.

The default value is 10.

Gamma

This threshold value mainly changes image contrast according
to the relative temperature of the scene.

® When the threshold value is > 0, it can increase the
contrast of the part with higher temperature in the scene,
and weaken the contrast of the part with lower temperature
(such as sky and ocean).

® When threshold value is < 0, it can weaken the contrast of
the part with higher temperature, and reserve more gray
level gradients to increase the part with lower temperature
in the scene.

The value ranges from -8 to 8. The default value is 3.

EZoom

It can zoom in part of the area in the scene to get clear view.

Smart Scene

The temperature measurement information of the image can be
well saved through smart scene function (for example, the gray
scale gradient difference between two objects can represent
the temperature difference between them). The image contrast
will be weakened to some extent.

The value ranges from 0~100, default is 15.

25
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Colorization Able to add color to the IR image, there are 4 colors to select:
White Hot:

In grayscale image, the place is brighter with higher
temperature.

Black Hot:

In grayscale image, the place is brighter with lower
temperature.

Ironbow?2: Color image with high brightness and contrast.
IceFire: In color image, the object with high temperature shows
IR, the object with low temperature shows blue. Generally it is
used as warning mode.

The default is white.

ROI Type Able to select such modes as: central point 25%, central point
50%, central point 75%, self-define, full screen, bottom, middle
and top.

Mirror Enable it then it will change the left, right direction of video
monitoring image. It is disable by default.

Flip Use this function to change the direction of video monitoring
Image. You can select 0° ,90° ,180° and 270° .Itis 0° by
Default.

Note: It needs to set the video resolution as 1080P or lower
when using flip mode function.

AGC It is to set the image AGC; it ranges from 0 to 255.

AGC Max Gain It is to set the image max AGC gain, it ranges from 0 to 255.
The higher the value is, the bigger the image contrastness
becomes, but with bigger noise.

AGC Plateau It is to set the image plateau AGC; it ranges from 0 to 255.

26



aJhua

TecHNOLGGY Dahua IR Thermal Imaging Network Camera Web3.0 Operation Manual

Gain Mode

There are three modes to select: low temperature, high
temperature and auto, it is low temperature by default. Under
auto mode, it can set the threshold of switching low
temperature to high temperature, low temperature area
percentage, threshold of switching high temperature to low
temperature, high temperature area percentage.

® |Low temperature mode, when the temperature exceeds
“threshold of switching low temperature to high
temperature” and the pixel point which exceeds threshold
is bigger than “low temperature area percentage’, then it
will auto switch to high temperature mode.

® High temperature mode, when the temperature is lower
than “threshold of high temperature switching to low
temperature”, and the pixel point which is lower than
threshold is bigger than “high temperature area
percentage”, then it will auto switch to low temperature
mode.

® Setting rules: the temperature threshold of low
temperature switching to high temperature needs to be
higher than that of high temperature switching to low
temperature, the sum of two area percentage need to be
bigger than 100.

Device
Information

Display device serial number, software version and firmware
version.

Click “Restore” to make the “Camera Condition” back to original state.

5.1.2 Video
5.1.2.1 Video bit stream

The video bit stream interface is shown as below. See Figure 5-2.

27
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@lhua

Video Snapshot Qverlay

Main Stream Sub Stream

#| Enable

Code-Stream Type General v Code-Stream Type General v

Encode Mode H 264H A Encode Mode H.264H v
Temperature Resolution SKGA (1280°1024) M Resolution NATIVE (6407512) v
Storage Frame Rate(FPS) 25 v Frame Rate(FPS) 15 v
System Bit Rate Type CBR v Bit Rate Type CBR v
Information Reference BitRate  640-8192Kb/S Reference Bit Rate  96-2048K0i5

Bit Rate 2048 v Bit Rate 192 v

| Frame Interval 50 (25~150) | Frame Interval 30 (15~150)

« Watermark Settings

Watermark Character| DigitalCCTV

petaut || Remesn || Save

Figure 5-2

Note:

Different stream may be corresponding to different default value, please refer to the actual interface for
details.

Please refer to the following sheet for detailed information.

Parameter Function

ACF means using different fps to record.

There are two options: VBR and CBR.

Please note, you can set video quality in VBR mode.

Encode mode There are four options: H.264 (main profile standard,

H.264H (high profile standard), and MJPG encode.

® The H.264, H.264H both are H264 bit stream.
H.264 is the Main Profile encode and you need to
enable the sub stream function in your camera and
set the resolution as CIF. Then you can monitor via
the Blackberry cell phone.

® MJIPEG: In this encode mode, the video needs
large bit stream to guarantee the video definition.
You can use the max bit stream value in the
recommended bit to get the better video output
effect.

Code-Stream Type
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Parameter

Function

Resolution

There are multiple resolutions. You can select from the
dropdown list.

For each resolution, the recommended bit stream value
is different.

Note: When video is under rotating status, you cannot
set resolution higher than 1080P (excluding 1080P).

Frame Rate

PAL: 1~25f/s, NTSC: 1~30f/s..
The frame rate may vary due to different resolutions.

Bit Rate Type

There are two options: VBR and CBR.
Please note, you can set video quality in VBR mode.
Under MJPEG mode, only CBR is available.

Recommended Bit

Recommended bit rate value according to the resolution
and frame rate you have set.

® In CBR, the bit rate here is the max value. In

Bit Rate o
dynamic video, system needs to low frame rate or
video quality to guarantee the value.
® The value is null in VBR mode.
® Please refer to recommend bit rate for the detailed
information.
| Frame Here you can set the P frame amount between two |

frames. The value ranges from 1 to 150. Default value
is 50.

Recommended value is frame rate *2.

Watermark Settings

By calibrating watermark, to see if video is modified.
Select Watermark function. Default watermark is Digital
CCTV.

Watermark character can only be number, letter, _, -
within 128 characters.

5.1.2.2 Snapshot

The snapshot interface is shown as in Figure 5-3.

@lhua

Camera Video
> Conditions
> Audio

Quality 5
Network

Interval 18
Event

Snapshot

Snapshot Type General

Image Size SXGA (128071024)

Temperature

Default

| ‘ Refresh ‘ ‘

Storage
System
Information
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Figure 5-3

Please refer to the following sheet for detailed information.

Parameter Function

Snapshot type There are two modes: General (schedule) and Event
(activation).

® General: to snapshot in the area set by the schedule.

® Event: to snapshot after triggering motion detect and local

alarm,
Image size It is the same with the resolution of snapshot (main stream or
sub stream).
Quality It is to set the image quality. There are six levels.
Interval It is to set snapshot frequency. The value ranges from 1s to 7s.

5.1.2.3 Video Overlay
The video overlay interface is shown as in Figure 5-4.

Snapshot Overlay

i d ® Disabl
2015-09-25 161132 Fri » Privacy Masking Enable Disable

» Channel Title

> Conditions

> Audio

Network Max20.5 > TimeTite

Event » TextOverlay
Temperature » Picture Overlay
Storage
System

Information

Min:11.4

Remove All Delete (Or Rightelick )

| Default | | Refresh l i Save

Figure 5-4
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@Jhua

Snapshot
> Conditions
> Audio
Network

Event

» Privacy Masking ® Enable Disable

» Channel Title Input channel title:

» Time Title TPC

» TextOverlay

Temperature » Picture Overlay

Storage
System

Information

Min:11.3

[ oeaut ][ Refesn ][ sawe

Figure 5-5

Snapshot

> Conditions .
» Privacy Masking ® Enable Disable

» Channel Title |¥] Week Display
> Audio

» TextOverlay

Network

Event

I
Temperature ; ' * o 4 £~ l
. -

Storage

» Picture Overlay

System

Information

Min:11.3

Defautt || Remesn | saw

Figure 5- 6

31



avsc!m'oeya Dahua IR Thermal Imaging Network Camera Web3.0 Operation Manual

@Jhua [T S pr— T ST mr——"

Snapshot Overlay

> Conditions

2015-09-25 16 » Privacy Masking Enable ‘® Disable
> Audio » Channel Title Input Text:
Network Max21.0 el S
Event asdfad ‘
Temperature » Picture Overlay asdfa |
Storage ‘ dasdfa |
System sdfas
Information Text Align
Right v

Min:11.2

pefaut|[ Refiesn |[ sawe

ua

TECHNOLOGY

Snapshot

» Privacy Masking Enable (@ Disable
> Audio » Channel Title Picture Preview:
Network » Time Title
Event » Text Overlay

» Picture Overlay

Temperature C
Storage \
System

Information

Upload Picture

Requirement for picture upload

1. Max size is 16k.

2. Max resolution is 128x128 pixels.
3. 256 colors, bmp format.

Min:11.0

pefaut|[ Reesn | saw

Figure 5-8

Please refer to the following sheet for detailed information.

Parameter Function

Privacy mask ® Here you can privacy mask the specified video in the
monitor video.

® System max supports 4 privacy mask zones.
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Time Title ® You can enable this function so that system overlays time
information in video window.
® You can use the mouse to drag the time tile position.
Channel Title ® You can enable this function so that system overlays
channel information in video window.
® You can use the mouse to drag the channel tile position.
Location ® You can enable this function to overlay location information
in video window.
® You can click on setup button to set location information.
You can use the mouse to drag location box to adjust its
position. Alignment include align left and align right.
Overlay ® You can enable this function to display overlay picture.
Click on disable to turn it off.
® Click on Upload Picture to overlay local picture into
monitoring window. You can drag the yellow box to move
it.
Note:
You cannot enable location and overlay at the same time.
Refresh ® Set privacy mask, channel title, time title, location, overlay
and save the change. You can click on Refresh to see
effect.
5.1.2.4 Path

Dahua IR Thermal Imaging Network Camera Web3.0 Operation Manual

The storage path interface is shown as in Figure 5-9.
Here you can set snap image saved path and the record storage path.

® The default monitor image path is C:\Documents and
Settings\Administrator\WebDownload\Snapshot.

® The default monitor record path is C:\Documents and
Settings\Administrator\WebDownload\LiveRecord.

® The default playback snapshot path is C:\Documents and
Settings\Administrator\WebDownload\PlaybackSnapshot.

® The default playback download path is C:\Documents and
Settings\Administrator\WebDownload\PlaybackRecord.

® The default playback cut path is: C:\Documents and
Settings\Administrator\WebDownload\VideoClips.

® The heat map path is: C:\\Documents and Settings\
Administraton\WebDownload\heatmap

Note:

Administrator is locally logged in PC account.
Please click the Save button to save current setup.
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alhua

- TECHNOLOGY

Video Snapshot Overlay

> Conditions . 5
_ Live Snapshot C:\Users\24766\WebDownload'LiveSnapshot
Video
Live Record C:\Users\24766\WebDownload\LiveRecord
> Audio
. Playback Snapshot  C:\Users\24766'WebDownload\PlaybackSnapshot
etworl
= Playback Download | C:\Users\24766\WebDownload\PlaybackRecord
Video Clips \Users\24766\WebDownload\Vi
Temperature p C:\Users\24766\WebDownload'VideoClips _
storage Heat Map Path. C:\Users\24766\WWebDownloadtheatmap

System Default ‘ | Save
Information

Figure 5-9

5.1.3 Audio

Please note some series devices do not support audio function.
5.1.3.1 Audio

The audio interface is shown as below. See Figure 5-10.

hua

- TECHNOLOGY

Audio

> Conditions Attribute
> Video
Sampling Frequency | 16K v
Network Microphone Valume (=) D 100
Event Main Stream Sub Stream
Temperature «| Enable «| Enable
Storage Encode Mode GT71A v Encode Mode GT11A v
System
Information Default | ‘ Refresh | ‘ Save

Figure 5-10

Please refer to the following sheet for detailed information.

Parameter Function

Sampling It includes two types of frequency: 8k and 16k.
Frequency

Microphone It is to set the microphone volume.

Volume

Audio enable ® Check “Enable”, the stream is A/V composite stream,

otherwise it contains video only.
® Audio is available only when video is enabled.

Encode mode The encode mode includes three modes: G.711A, G.711Mu
and AAC. The default is G.711A.
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5.2 Network

5.2.1 TCP/IP
The TCP/IP interface is shown as in Figure 5-11. It supports IPv4 and IPv6. IPv4 supports static IP and

DHCP. IPv6 supports static IP only. When users manually modify IP address, WEB will automatically

jump to the new IP address.

@hua

NOLOGY
Camera

TCPIP

> Connection

> PPPoE

> DDNS

> IP Filter

> SMTP{Email)
> UPnP

> SNMP

> Bonjour

> Multicast

TCPNP

Host Name

Ethernet Card
Wode

WAC Address
IP Version I
IP Address

Subnet mask

Default Gateway
Preferred DNS Server,

Alternate DNS Server

TPC

3

g .

Wire(DEFAULT) v
*® Static' DHCP

09
6
0
0
3

] 4 .

> 802.1x

#| Enable ARP/Ping to set P address service
> QoS &

Event Default || Refresh H

Temperature

Storage

System

Information

Figure 5-11
Please refer to the following sheet for detailed information.

Parameter Function

Host Name It is to set current host device name. It max supports 15
characters.

Ethernet Card Please select the Ethernet port. Default is wired.

Please note you can modify the default Ethernet card if there is
more than one card. .

Please note the device needs to reboot to activate the new
setup once you modify the default setup.

Mode There are two modes: static mode and the DHCP mode. Select
DHCP mode, it auto searches IP, and you cannot set IP/subnet
mask/gateway. Select static mode, you must manually set
IP/subnet mask/gateway.

Mac Address It is to display hose Mac address.
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IP Version It is to select IP version. IPV4 or IPV6.
You can access the |IP address of these two version.
IP Address Please use the keyboard to input the corresponding number to

modify the IP address and then set the corresponding subnet
mask and the default gateway.

Preferred DNS

DNS IP address.

Alternate DNS

Alternate DNS IP address.

Enable
ARP/Ping set
device IP

address service.

You can use ARP/Ping command to modify or set the device IP
address if you know the device MAC address.

Before the operation, please make sure the network camera
and the PC in the same LAN. This function is on by default.

You can refer to the steps listed below.

Step 1: Get an IP address. Set the network camera and the PC
in the same LAN.

Step 2: Get the physical address from the label of the network
camera.

Step 3: Go to the Run interface and then input the following
commands.

arp —s <IP Address> <MAC>

ping —I 480 —t <IP Address>

Such as: arp -s 192.168.0.125 11-40-8c-18-10-11
ping -I 480 -t 192.168.0.125

Step 4: Reboot the device.

Step 5: You can see the setup is OK if you can see there are
output information such as “Reply from 192.168.0.125 ...” from
the command output lines. Now you can close the command
line.

Step 6: Open the browse and then input http://<IP address>.
Click the Enter button, you can access now.

5.2.2 Connection
5.2.2.1 Connection

The connection interface is shown as in Figure 5-12.
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@lhua

Camera Connection
Network
> TCPIP

Max Connection

(1~20)

TCP Port 37777 (1025-65534)

UDP Port 37778 (1025~65534)

> PPPOE
HTTP Port 80

> DDNS

5 PES RTSP Port 554

> SMTP(Email) s

> UPnP HTTPs Port 443

> SNMP |

petaut || Remesn | Save

> Bonjour

> Multicast

> 802.1x

> QoS

Event
Temperature

Storage

System

Information

Figure 5-12

Please refer to the following sheet for detailed information.

Parameter | Function

Max It is the max Web connection for the same device. The value ranges from 1
connection | to 20. Default connection amount is 10.

TCP port Port range is 1025~65534. The default value is 37777. You can input the
actual port number if necessary.

UDP port | Portrange is 1025~65534. The default value is 37778. You can input the
actual port number if necessary.

HTTP port | Port range is 1025~65524. The default value is 80. You can input the
actual port number if necessary.
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RTSP port | ® The default value is 554. Please leave blank if use default. User uses
QuickTime or VLC can play the following formats. BlackBerry can play
too.

® Real-time monitoring URL format, please require real-time RTSP
media server, require channel no., bit stream type in URL. You may
need username and password.

Dahua IR Thermal Imaging Network Camera Web3.0 Operation Manual

® User uses BlackBerry need to set encode mode to H.264B, resolution
to CIF and turn off audio.

URL format is:
rtsp://username:password@ip:port/cam/realmonitor?channel=1&subtype=0
username/password/IP and port.

The IP is device IP and the port default value is 554. You can leave it in
blank if it is the default value.

Follow standard RTP protocol and when encode mode is MJPEG, the max
resolution only supports 2040*2040.

HTTPs Check HTTPs enable, login as https://ip:port. Protect data. Default port is
Enable ttps://ip . It is disabled by default.

HTTPs HTTPs communication port, range is 1025~65534, default is 443.
Port

Note:

® (0~1024, 37780~37880, 1900, 3800, 5000, 5050, 9999, 37776, 39999, 42323 are all special ports.
User cannot modify them.

® Avoid using default port value of other ports.

5.2.2.1 ONVIF

ONVIF (Open Network Video Interface Forum) , this standard describes network video mode,
interface, data type and data interaction mode. ONVIF Standard’s aim is to achieve a network video
frame agreement and makes the network video products (including video front-end, video equipment,
etc.) from different manufacturers completely compatible.

ONVIF function default is closed.
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CZNOU?C-‘#
Camera Connection ONVIF
Network
Authentication * Enable Disable
> TCPi

> PPPoE

> DDNS
> IP Filter

> SMTP(Email)

> UPnP

> SNMP

> Bonjour

> Multicast

> 802 1x

> QoS

Event
Temperature
Storage
System

Information

Figure 5-13
5.2.3 PPPoOE
The PPPOE interface is shown as in Figure 5-14.
Input the PPPoE user name and password you get from the IPS (internet service provider) and enable
PPPoE function. Please save current setup and then reboot the device to get the setup activated.
Device connects to the internet via PPPoE after reboot. You can get the IP address in the WAN from
the IP address column. When PPPOE is on, please disable UPnP to avoid influence on dial-up.
When you Check PPPoE enable, please disable UPnP.
Please note, you need to go to the IP address item to via the device current device information.
You can access the client-end via this address.

@lhua

Camera PPPcE

Enable

Username
> Connection

Password
PPPOE

> DDNS Default H Refresh || Save

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

> Multicast

Temperature

Storage

System

Information

Figure 5-14
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5.2.4 DDNS

The DDNS interface is shown as in Figure 5-15.

The DDNS is to set to connect the various servers so that you can access the system via the server.
Please go to the corresponding service website to apply a domain name and then access the system
via the domain. It works even your IP address has changed. When the device connects to WLAN, you
should disable UPnP.
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@lhua

Camera DDNS

Network

Server Type Dahua DDNS
> TCPAP

Server Address www._dahuaddns.com
> Connection

Mode ® Auto Manual
> PPPoE

DDNS

> IP Filter

Domain Name 201507141509 .dahuaddns.com

Username {Optional)Please input the mailbox

> SMTP(Email) Default ‘ | Refresh ‘ | Save
> UPnP

> SNMP
> Bonjour
> Multicast
> 802.1x
> QoS
Event

Temperature

Storage

System
Information

Figure 5-15

Please refer to the following sheet for detailed information.

Parameter Function

Server Type You can select DDNS protocol from the dropdown list: CN99
DDNS, NO-IP DDNS, Dyndns DDNS, QUICK DDNS, Private
DDNS, the default is QUICK DDNS.

Server Address | DDNS server IP address

CN99 DDNS

Server address: www.3322.0rg
NO-IP DDNS

Server address: dynupdate.no-ip.com
Dyndns DDNS

Server address: members.dyndns.org
Other DDNS

Mode Default is auto, able to choose manual
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Parameter Function

Domain Name | Both auto and manual are “MAC addresss.dahuaddns.com”by
default, able to set prefix manually.

Username The user name you input to log in the server, optional.

The CN99 DDNS interface is shown as in Figure 5-16.

@lhua

TECHNOLOGY

Camera DDNS

Network

Server Type CH99 DONS
> TCPAP

Server Address www.3322 org
> Connection

Domain Name none

> PPPOE

DDNS

> IP Filter
> SMTP{Email) Update Period 10 Minutes (1~500)

Username none

Password

» e Default ‘ | Refresh ‘ | Save

> SNMP

> Bonjour

> Multicast

> 802.1x

> Qos

Event
Temperature

Storage

System

Information

Figure 5-16

Parameter Function

Server Type You can select CN99 DDNS protocol

Server Address | Under CN99 DDNS the default server address is “www.3322.0org”

Domain Name Self-defined domain name

Username The user name you input to log in the server.

Password The password you input to log in the server

The refresh period of the connection between the device IP and the server, default

Refresh Period | ic'10 minutes.

5.2.5 IP filter

The IP filter interface is shown as in Figure 5-17.

You can enable IP filter function so that some specified IP/MAC user can access the network camera.
You can add IP address or IP address section.
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If you do not check the box here, it means there is on access limit.

Here you can add IP address and MAC address. You must add these addresses before enabling the
trusted sites.

Please note: You must set MAC address in the same network segment.

hua

- TECHNOLOGY

Camera IP Filter

Trusted Sites

Trusted Sites

> Connection IP address /MAC address Modify Delete

> PPPoE
> DDNS
> SMTP(Email)
> UPnP
> SNMP

> Bonjour

> Multicast

> 802.1x Add IPIMAC Remove All

> QoS

| Default H Refresh H Save
Event

Temperature

Storage

System

Information

Figure 5-17

5.2.6 SMTP (e-mail)
The SMTP interface is shown as in Figure 5-18.

@lhua

Camera SMTP(Email)

SMTP Server none
> T
Port 25
» Connection
Anonymity
> PPPoE
Username
5 TS anonymity
> IP Filter Fassword
SUTPEmail) Sender none
»{Li? Authentication None v
> SNMP
Title Message | Attachment
> Bonjour
ail Receiver
> Multicast
> 802.1x
> QoS
Event Interval 0 Minutes (0~1440)
Temperature Health Mail Update Period 1 Minutes (0~1440)
Storage
Email Test
System
Information | Default | | Refresh | ‘ Save
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Figure 5-18
Please refer to the following sheet for detailed information.
Parameter Function
SMTP Server Input server address and then enable this function.
Port Default value is 25. You can modify it if necessary.
Anonymity For the server supports the anonymity function. You can auto
login anonymously. You do not need to input the user name,
password and the sender information.
User Name The user name of the sender email account.
Password The password of sender email account.
Sender Sender email address.
Authentication You can select SSL, TLS or none.
(Encryption
mode)
Title (Subject) Input email subject here.
Attachment System can send out the email of the snapshot picture once
you check the box here.
Mail receiver Input receiver email address here. Max three addresses.
Interval The send interval ranges from 0 to 3600 seconds. 0 means
there is no interval.
Please note system will not send out the email immediately
when the alarm occurs. When the alarm, motion detection or
the abnormity event activates the email, system sends out the
email according to the interval you specified here. This
function is very useful when there are too many emails
activated by the abnormity events, which may result in heavy
load for the email server.
Health mail Please check the box here to enable this function.
enable
Email test The system will automatically sent out a email once to test the
connection is OK or not .Before the email test, please save
the email setup information.
5.2.7 UPnP

It allows you to establish the mapping relationship between the LAN and the public network.
Here you can also add, modify or remove UPnP item. For UPnP on different routers, you must disable
UPnNP function. See Figure 5-19.
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In the Windows OS, From Start->Control Panel->Add or remove programs. Click the “Add/Remove
Windows Components” and then select the “Network Services” from the Windows Components Wizard.
Click the Details button and then check the “Internet Gateway Device Discovery and Control client” and
“UPnP User Interface”. Please click OK to begin installation.

Enable UPnP from the Web. If your UPnP is enabled in the Windows OS, the network camera can auto
detect it via the “My Network Places”.

Under manual mode, you can modify external port. Under auto mode, select idle port for auto port
mapping without user modification.

@lhua

Camera UPnP

Enable

Mode | Manual v Router State Mapping Failed
> TCPIP _ .
Port Mapping List

> Conneclion

Service Name Protocol Internal Port External Port Status Modify
> PPPoE Ldl HTTP WebSernvice TCP 80 8080 Mapping Failed
> DDNS G TCP PrivSenvice:TCP T T Mapping Failed
> IP Filter i uDP PrivService:UDP 37778 37778 Mapping Failed
> SMTP(Email) G RTSP RT8PSenice TGP 554 554 Mapping Failed

> SNMP

> Bonjour

> Multicast

B il Default | ‘ Refresh | ‘

> QoS

Event

Temperature

Storage

System
Information

Figure 5-19

5.2.8 SNMP

The SNMP interface is shown as in Figure 5-20 and Figure 5-21.

The SNMP allows the communication between the network management work station software and the
proxy of the managed device. Please install the software such as MG MibBrowser 8.0c software or
establish the SNMP service before you use this function. You need to reboot the device to activate the
new setup.
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@lhua

Camera SNMP

Network

SNMP Version

SHNMP w1 SMMP v2 ShMP v3

> TCPAP
> Connection SNMP Port 161 (1~65535)
> PPPoE Read Community public

> DDNS Write Community private

> 1P Filter Trap Address

> SMTP{Email) Trap Port 162

> UPnP

SHMP

> Bonjour Default ‘ | Refresh | ‘ Save

Keep Alive

> Multicast

> 802.1x

> QoS

Event
Temperature
Storage

System

Information

Figure 5-20

Please refer to the following sheet for detailed information.

Parameter Function

SNMP Version ® Check SNMP v1, device only process vl info.
® Check SNMP v2, device only process v2 info.

® Check SNMP v3, can set username, password and
encryption method. Server calibrate corresponding
username, password and encryption method too access
device and v1/v2 are unavailable.

SNMP port The listening port of the proxy program of the device. It is a
UDP port not a TCP port. The value ranges from 1 to 65535.
The default value is 161

Community It is a string, as command between management and proxy, ,
defining a proxy, and a manager’s authentication.

Read community Read-only access to all SNMP targets, default is public.
Note: Only number, letter, , and — supported.

Write community Read/write access to all SNMP targets, default is private.

Note: Only number, letter, , and — supported.

Trap address The destination address (_)f the Trap information from the

proxy program of the device.

Trap SNMP trap is a proxy message sent to admin as important
event notice or status change.
Trap Address Address where to send Trap message.
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Parameter Function
Trap Port Port which send Trap message, default is 162, range
1~65535.

[ IE]

TECHNOLOGY

Camera SNMP

Network SNMP Version

SNMP w1 SNMP w2 ¢ SNMPv3

> TCPAP

> Connection SNMP Port 161 (1~65535)
> PPPoE Read Community public

> DDNS Write Community private

> IP Filter Trap Address

P ETIHE ) Trap Port 162

p LAy Keep Alive

> Bonjour Read-only Username public

> Multicast Authentication Type * MD5 SHA
> 802.1x Authentication Password

> Qos Encryption Type ® CBC-DES

Event Encryption Password

Temperature
Storage Read&write Usemame  private

System Authentication Type & MD5 8HA
Information Authentication Password
Encryption Type ® CBC-DES

Encryption Password

petaut || Remeen || Save

Figure 5-21

Check SNMP v3 version and SNMP port, read community, write community, Trap address, Trap port
are same with SNMP v1 and SNMP v2 versions. Only when SNMP version is SNMP v3, users need to
configure parameter in chart.

Parameter Function

SNMP Version | SNMP v3
Default is public.

Read-only .
Username Note:

Name only can be number, letter and underline.
Read/Write Defa.ult is private.

Note:
Username

Name only can be number, letter and underline.
Authentication You may select MD5 or SHA, default is MD5.

Authentication

Password not less than 8 characters.
Password
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Parameter Function
Encryption Default is CBC-DES.
Encryption
Password Password not less than 8 characters.

5.2.9 Bonjour

The Bonjour interface is shown as below. See Figure 5-22.

Bonjour is based on the multicast DNS service from the Apple. The Bonjour device can automatically
broadcast its service information and listen to the service information from other device.

You can use the browse of the Bonjour service in the same LAN to search the network camera device
and then access if you do not know the network camera information such as IP address.

You can view the server name when the network camera is detected by the Bonjour. Please note the
safari browse support this function. Click the “Display All Bookmarks: and open the Bonjour, system can
auto detect the network camera of the Bonjour function in the LAN.

@hua

Camera Bonjour
Network
> TCPIP

| Enable

Server Name 20-15-07-14-15-09
> Connection

» PPPoE Default ‘ | Refresh | | Save

> DDNS

> IP Filter

> SMTP{Email)
> UPnP

> SMMP

> Multicast

> 802 1x

> QoS

Event
Temperature
Storage
System
Information

Figure 5-22

5.2.10 Multicast

The multicast interface is shown as in Figure 5-23.

Multicast is a transmission mode of data packet. When there is multiple-host to receive the same data
packet, multiple-cast is the best option to reduce the broad width and the CPU load. The source host
can just send out one data to transit. This function also depends on the relationship of the group
member and group of the outer.

Note:
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® Open preview, streaming media protocol, select multicast, and monitor via multicast format.

® Here you can set multicast address and port. You also need to go to Live interface to set the
protocol as Multicast.

@Jhua

NOLOGY

Camera Multicast
Network

> TCPAP

Sub Stream

Main Stream

#| Enable «| Enable

> Connection

Multicast Address 224 1 2 4 | (224.0.0.0~239.255 255 255) Multicast Address 224 1 2 4 | (224.0.0.0~239.255 255 255)
> PPPOE

Port 40000 (1025~65534) Port 40008 (1025~65534)

> DDNS

> IP Filter

> SMTP{Email) Default ‘ | Refresh | ‘ Save

> UPnP

> SNMP

> Bonjour

Multicast

> 802.1x

> QoS
Event
Temperature

Storage

System

Information

Figure 5-23

Please refer to the following sheet for detailed information.

Parameter Function

Enable Select to enable multicast function. Main stream and sub stream cannot be
used at the same time.

Multicast address Main/sub stream multicast default address is 224.1.2.4 and its range is
224.0.0.0~239.255.255.255.

Port Multicast port. Main stream is 40000, sub stream is 40002 and the range is
1025~65534.

5.2.11 802.1x

802.1x (port based network access control protocol) supports manual selection of authentication
method to control if device connected to LAN can join the LAN. It well supports authentication, charging,
safety and management requirement of network.
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@lhua

Camera 802.1x

Enable

Authentication PEAP v
> Connection

Username none

> PPPOE

Password
> DDNS

> IP Filter Detault || Refresh H Save
> SMTP(Email)

> UPnP

> SNMP

> Bonjour

> Multicast

> QoS

Event
Temperature

Storage

System

Information

Figure 5-24
Please refer to the following sheet for detailed information.

Parameter Function

Authentication | PEAP (protected EAP protocol).

Username It needs the username to login, which is authenticated by the
server.
Password Please input password here.
5.2.12 QoS

The QoS interface is shown as below. See Figure 5-25.

Qos (Quality of Service) is network security mechanism. It is a technology to fix the network delay and
jam problem and etc. For the network service, the quality of service includes the transmission bandwidth,
delay, the packet loss and etc. We can guarantee the transmission bandwidth, lower the delay, reduce
the loss of the data packet and anti-dither to enhance the quality.

We can set the DSCP (Differentiated Services Code Point) of the IP to distinguish the data packet so
that the router or the hub can provide different services for various data packets. It can select the
different queues according to the priority (64 different priority levels) of the packets and select the
bandwidth of the each queue. Level 0 is the lowest, and level 63 is the highest. It can also discard at the
different ratio when the broad bandwidth is jammed.
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Camera Qos

Realtime Monitor 0 (0~63)
> TCPAP

Command 0 (0~63)
> Connection

> PPPoE ‘ |

Default Refresh H Save

> DDNS
> IP Filter
» SMTP(Email)
> UPnP
> SNMP
> Bonjour
> Multicast
> 802.1x

QoS
Event
Temperature
Storage
System
Information

Figure 5-25
Please refer to the following sheet for detailed information.
Parameter Function
Real-time The value ranges from 0 to 63. The router or the switcher can
monitor provide different service for various data packets.
Command The value ranges from 0 to 63. The router or the switcher can
provide different service for various data packets.
Enable Check it to enable QoS.
Wireless QoS
5.3 Event

5.3.1 Video detect
5.3.1.1 Motion Detect
The motion detect interface is shown as in Figure 5-26 through Figure 5-27.
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> IVS Analys

> Temperature Alarm
> Fire Alarm

> Alarm

> Abnormality
Temperature

Storage

System
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Motion Detect

|| Enable

‘Working Period

Anti-Dither [t |seconao-100)
|# Record

Record Delay Second (10~300)
|# Relay-out

Alarm Delay Second (10~300)

|| Send Email

] Snapshot

Save

Default H Refresh H

Figure 5-26

Working Period

=
ra
=
(=}
==}

10 12 14 16 18 20 24

G511 s I T T A
oL ]
Tuesday T T T e e e e P e T
e
Wednesday |7 T T T TP P PP e T P T
oL ]
Friday T e T
oL
] An Sunday [] Monday [C] Tuesday [| Wednesday [| Thursday [] Friday [_| Saturday
[/] Pefiod1: | 00 : 00 : 00 |-| 23 - 59 ° &9 |
[] Period2: | 00 : 00 : 00  -| 23 : 59 : 59 |
[] Period3: | 00 - 00 - 00 -| 23 = 59 - 59 |
[] Period4: | 00 : 00 : 00 |-| 23 - 59 : 59 |
[] Period5: | 00 : 00 : 00 -| 23 - 59 : 59 |
[ Periodd | 00 : 00 : 00 |-| 23 - 59 : 59 |
| Save H Cancel |
Figure 5-27
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Please refer to the following sheet for detailed information.

Parameter Function

Enable You need to check the box to enable motion detection function.

Working Here you can set arm/disarm period. Click on set button to open period

Period setup menu.

There are six periods every day for setup and you must check box in front of
each period to enable it.

Note: Period setup can be done by dragging mouse while not release left
mouse.

Anti-dither System only memorizes one event during the anti-dither period. The value
ranges from 0s to 100s.

Area Here you can set motion detection region and its sensitivity and area. (The
higher the sensitivity is, the easier to trigger motion detect; the smaller the
area, the easier to trigger motion detect.) The default covers all regions. You
must click on save before enabling your setup.

Record Check it and so when alarm occurs, system will auto record. You shall set

record period in Storage>Schedule and select auto record in record control
interface.

Record Delay

System can delay the record for specified time after alarm ended. The value
ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended. The
value ranges from 10s to 300s.

Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Snapshot You need to check the box here so that system can backup motion detection

snapshot file. You shall set snapshot period in Storage>Schedule.

See Figure 5-28.
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Figure 5-28

Different colors represent different areas. Each area can set different detection zones. Detection zone
can be irregular and discontinuous. If device monitoring zone is large, user can sub-divide the area into
several zones for better motion detect.

Please refer to the following sheet for detailed information.

Parameter

Function

Name

Default area name includes Region0, Regionl, Region2,
Region3 and custom.

Sensitivity

It is sensitivity of brightness as motion detection is more possible
to be trigger with high sensitivity. You can set up to four areas.
The range is 0~100. The recommenced value is 30~70.

Area threshold

It is to check target object area related to detection area. The
lower the area threshold, the easier to trigger motion detection.
You can set up to four areas. The range is 0~100. The
recommenced value is 0~10.

Waveform

Red means motion detect is triggered. Green means motion
detect is not triggered.

53



@an Dahua IR Thermal Imaging Network Camera Web3.0 Operation Manual

Delete all Clear all areas.

Delete Delete selected area.

5.3.2 IVS Analyse

Note:
Some models don’t support IVS Analyse function. See Figure 5-29.

5.3.2.1 Tripwire

Camera Tripwire

Network ¥ Enable

> Video Detect Rule List ar
1 linet ki
> Temperature Alarm 2 line2 i
> Fire Alarm
> Alarm
> Abnormality
—Parameter Setup
Temperature
Storage Working Period
Min:10.7
System 3
b ——
Information — . Direction A<->B v
v Record
R I 10~
ecord Delay | 10 | second (10~200)
— ¥ Relay-out
TergetEier D WaxSize DrawTamet AlarmDelay |10 | second (10~300)
Min Size
| Send Email
|_| Snapshot

[ Default H Refresh ” Save

Figure 5-29

54



@hua

Dahua IR Thermal Imaging Network Camera Web3.0 Operation Manual

Working Period

14

Sunday || LU PP P P P P P e P e P e e e e e e e e el
T T T I ==
Wednesday
] A «| Sunday || Monday || Tuesday [ | Wednesday [ | Thursday [ | Friday [ | Saturday
# Periodd: | 00 : 00 : 00 |-| 23 : 59 : 59 |
() Period2 | 00 : 00 : 00 |-| 23 : 59 : 59 |
| ) Period3 00 : 00 : 00 |- 23 @ 59 : &9 |
() Period4: | 00 : 00 : 00 |- 23 : 59 : 59 |
| ) PeriodS | 00 : 00 : 00 |- 23 : 59 : 59 |
| ) Period6: 00 : 00 : 00 |- 23 @ 59 : &9 |
| Save || Cancel
Figure 5-30
Parameter Note
Enable Check it to enable tripwire rule.
Add/Clear Click 4 to add rule. Click I to clear rule.
Draw Rule Click it to draw corresponding rule in the image.
Clear Click it to clear the drawn rules.
. . . . . DrawTarget .
After selecting max size or min size, click button to draw the size
Target Filter _ o _ _ Clear
model of filter target aiming at this rule; click button to clear the target
filter model which has been drawn.
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Parameter Note
® |tis to set the alarm period, it can enable alarm event only in the set time range.
® There are six periods every day for setup and you must check box in front of
each period to enable it.
® Select days (Sunday by default, if select all the week, then it means applying
Working the setup into the whole week; you can also check the box in front of the day
Period and make setting for some days separately).
® (Click “OK” button after completing setup, go back to motion detect setting page,
click “OK” button to finish working period setup of motion detect
Note: Period setup can be done by dragging mouse while not releasing left mouse.
Direction It is to select tripwire direction, you can select A->B. B->A. A<->B
Record Check it and so when alarm occurs, system will auto record. You shall set record

period in Storage>Schedule and select auto record in record control interface.

Record Delay

System can delay the alarm record for specified time after alarm ended. The value
ranges from 10s to 300s.

Check it to enable alarm activation output port, the system can activate

Relay out corresponding alarm output device when alarm occurs.
Alarm Dela: System can delay the alarm output for specified time after alarm ended. The value
y ranges from 10s to 300s.
. If you enabled this function, System can send out email to alert you when
Send Email alarm occurs. User can set his email address in Network>SMTP.
You need to check the box here so that system can auto alarm snapshot when
Snapshot

alarm occurs. You shall set snapshot period in Storage>Schedule.
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5.3.2.2 Intrusion

Camera Intrusion

Network
\¥) Enable

> Video Detect Rule List dh
. i 2 1 areal o
> Temperature Alarm
> Fire Alarm
> Alarm
> Abnormality Drawing isf£ompleted!
r Setul
Temperature ' P
storage Working Period
Syst Min:10.7
ystem -

Information Direction Enter&leave v

¥/ Record

Record Delay | 10 | second (10~300)
—— | Relay-out
LR oMo e Draw Target Alarm Delay |10 | second (10~300)
! Min Size
_| Send Email
|| Snapshot
[ oeaur |[ Rewesn [ sae

Figure 5-31
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Working Period

Sunday Setup
Tuesday [ T P P P
T T [ S
Wednesday
[ Al < Sunday [ Monday || Tuesday || Wednesday [ Thursday [ | Friday [ Saturday
¥ Period1: | 00 - 00 : 00 |-| 23 : 59 : £9 |
() Period2 | 00 : 00 : 00 |-| 23 : 59 : 53 |
() Period3 | 00 : 00 : 00 |-| 23 : 59 : 53 |
() Period4 | 00 : 00 : 00 |-| 23 : 59 : 53 |
() PeriodS: | 00 : 00 : 00 |-| 23 : 59 : 59 |
| ) Period® | 00 : 00 : 00 |-| 23 : 59 : 59 |
| Save || Cancel
Figure 5-32
Parameter Note
Enable Check it to enable intrusion.
Add/Clear Click & to add rule. Click T to clear rule.
Draw Rule Click it to draw corresponding rule in the image.
Clear Click it to clear the drawn rules.

Target Filter

After selecting max size or min size, click button

model of filter target aiming at this rule; click button
filter model which has been drawn.

Draw Target

Clear

to draw the size

to clear the target
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Parameter Note
® |tis to set the alarm period, it can enable alarm event only in the set time range.
® There are six periods every day for setup and you must check box in front of
each period to enable it.
® Select days (Sunday by default, if select all the week, then it means applying
Working the setup into the whole week; you can also check the box in front of the day
Period and make setting for some days separately).
® (Click “OK” button after completing setup, go back to motion detect setting page,
click “OK” button to finish working period setup of motion detect
Note: Period setup can be done by dragging mouse while not releasing left mouse.
Direction It is to select intrusion direction; you can select Enter, Leave, Enter & Leave.
Record Check it and so when alarm occurs, system will auto record. You shall set record

period in Storage>Schedule and select auto record in record control interface.

Record Delay

System can delay the alarm record for specified time after alarm ended. The value
ranges from 10s to 300s.

Check it to enable alarm activation output port, the system can activate

Relay out corresponding alarm output device when alarm occurs.

System can delay the alarm output for specified time after alarm ended. The value
Alarm Delay

ranges from 10s to 300s.

_ If you enabled this function, System can send out email to alert you when

Send Email alarm occurs. User can set his email address in Network>SMTP.

You need to check the box here so that system can auto alarm shapshot when
Snapshot

alarm occurs. You shall set snapshot period in Storage>Schedule.

5.3.2.3 Scene Change

alhua

TECHNOLOGY

Camera
Network

> Video Detect

IVS Analyse

> Temperature Alarm

> Fire Alarm

> Alarm

> Abnormality
Temperature

Storage

System

Information

| Enable

#| Record

#| Relay-out

Scene Change

Tripwire Intrusion

Waorking Period

Record Delay | 10 Second (10~300)

Alarm Delay 10 Second (10~300)
Send Email

Snapshot

Default || Refresh H Save ‘

Figure 5-33
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Working Period

Monday |1 e e
0 T A N
Tuesday | e P T T T
0 I N
Wednesday T e e e T
0 T A N
L AN # Sunday [ Monday || Tuesday [ | Wednesday | | Thursday || Friday [ Saturday
@ Period1 | 00 : 00 - 00 [-| 23 : 59 : 59 |
() Period2 | 00 : 00 : 00 |-| 23 : 59 : 59 |
() Period3: | 00 : 00 : 00 |-| 23 : &9 : 59 |
L) Period4: | 00 : 00 0 00 [-| 23 : 59 : 59 |
() Period5: | 00 : 00 : 00 |-| 23 : 59 : 59 |
() Perid® | 00 : 00 : 00 |-| 23 : &9 : 59 |
‘ Save H Cancel
Figure 5-34
Parameter Note
Enable Check it to enable scene change function.
® |tis to set the alarm period, it can enable alarm event only in the set time range.
® There are six periods every day for setup and you must check box in front of
each period to enable it.
® Select days (Sunday by default, if select all the week, then it means applying
Working the setup into the whole week; you can also check the box in front of the day
Period and make setting for some days separately).
® Click “OK” button after completing setup, go back to motion detect setting page,
click “OK” button to finish working period setup of motion detect
Note: Period setup can be done by dragging mouse while not releasing left mouse.
Record Check it and so when alarm occurs, system will auto record. You shall set record

period in Storage>Schedule and select auto record in record control interface.

Record Delay

System can delay the alarm record for specified time after alarm ended. The value
ranges from 10s to 300s.
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Parameter Note

Check it to enable alarm activation output port, the system can activate
Relay out . '

corresponding alarm output device when alarm occurs.

System can delay the alarm output for specified time after alarm ended. The value
Alarm Delay

ranges from 10s to 300s.

_ If you enabled this function, System can send out email to alert you when
Send Email alarm occurs. User can set his email address in Network>SMTP.
Snapshot You need to check the box here so that system can auto alarm snapshot when
P alarm occurs. You shall set snapshot period in Storage>Schedule.

5.3.3 Temperature Alarm
Note:
Some models don’t support temperature alarm function.

hua
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Camera
Network

Temperature Alarm

Enable

> Video Detect Waorking Period

> VS Analyse Anti-Dither 0

Temperature Alarm

> Fire Alarm

Second (0~100)

«| Record

Recaord Delay 10 Second (10~300)

> Alarm

LY

> Abnormality Relay-out

Alarm Delay Second (10~300)

Temperature

Storage Send Email

System

Snapshot

Information | ‘

Default Refresh H Save

Figure 5-35

Parameter Note

Enable You need to check the box to enable alarm activation
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Parameter Note
® |tis to set the alarm period, it can enable alarm event only in the set time range.
® There are six periods every day for setup and you must check box in front of
each period to enable it.
® Select days (Sunday by default, if select all the week, then it means applying
Working the setup into the whole week; you can also check the box in front of the day
Period and make setting for some days separately).
® Click “OK” button after completing setup, go back to motion detect setting page,
click “OK” button to finish working period setup of motion detect
Note: Period setup can be done by dragging mouse while not releasing left mouse.
I System only memorizes one event during the anti-dither period. The value ranges
Anti-Dither
from Os to 100s.
Record Check it and so when alarm occurs, system will auto record. You shall set record

period in Storage>Schedule and select auto record in record control interface.

Record Delay

System can delay the alarm record for specified time after alarm ended. The value
ranges from 10s to 300s.

Check it to enable alarm activation output port, the system can activate

Relay out corresponding alarm output device when alarm occurs.
Alarm Dela: System can delay the alarm output for specified time after alarm ended. The value
y ranges from 10s to 300s.
_ If you enabled this function, System can send out email to alert you when
Send Email alarm occurs. User can set his email address in Network>SMTP.
You need to check the box here so that system can auto alarm shapshot when
Snapshot

alarm occurs. You shall set snapshot period in Storage>Schedule.

5.3.4 Fire Alarm

Note:

Some models don’t support fire alarm function.
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Network
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> Video Detect ¢
Target Size 10 | pX
> IVS Analyse
it © (0@ 100
> Temperature Alarm .
e bl — Measurement ltems
> Aam 1:Detect Area i}
> Abnormality 2-Detect Area i
Temperature -
Storage
Min: 102
System
Information Parameter Setup
Working Period
Anti-Dither 0 Second (0~100)
«! Record
Record Delay 10 Second (10~300)
«| Relay-out
Alarm Delay 10 Second (10~300)
Send Email
Snapshot
efaut [ Reiesn ][ sa
Figure 5-36
Parameter Note
Enable You need to check the box to enable local config function.
Target Size It is to the minimum target which can be recognized by fire alarm, it will generate
alarm when exceeding target pixel.
Sensitivity It is to set the alarm sensitivity, ranging from 1 to 100. The higher the sensitivity is,
the easier it will generate alarm, but it may generate false alarm.
Redraw Rule . Redraw Rule .
Click to redraw the corresponding rules.

Measurement Click

tems to add new area, click the corresponding I to delete the measurement

item.
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Parameter Note
® |tis to set the alarm period, it can enable alarm event only in the set time range.
® There are six periods every day for setup and you must check box in front of
each period to enable it.
® Select days (Sunday by default, if select all the week, then it means applying
Working the setup into the whole week; you can also check the box in front of the day
Period and make setting for some days separately).
® Click “OK” button after completing setup, go back to motion detect setting page,
click “OK” button to finish working period setup of motion detect
Note: Period setup can be done by dragging mouse while not releasing left mouse.
I System only memorizes one event during the anti-dither period. The value ranges
Anti-Dither
from Os to 100s.
Record Check it and so when alarm occurs, system will auto record. You shall set record

period in Storage>Schedule and select auto record in record control interface.

Record Delay

System can delay the alarm record for specified time after alarm ended. The value
ranges from 10s to 300s.

Check it to enable alarm activation output port, the system can activate

Relay out corresponding alarm output device when alarm occurs.

System can delay the alarm output for specified time after alarm ended. The value
Alarm Delay

ranges from 10s to 300s.

_ If you enabled this function, System can send out email to alert you when fire

Send Email alarm occurs. User can set his email address in Network>SMTP.

You need to check the box here so that system can auto alarm snapshot when
Snapshot

alarm occurs. You shall set snapshot period in Storage>Schedule.
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Please note some series products do not support this function.

5.3.5.1 Alarm

@lhua

Camera Relay Activaticn

Network

Event
> Video Detect
> IVS Analyse
» Temperature Alarm
> Fire Alarm
> Abnormality
Temperature
Storage
System

Information

LY

Enable

Relay-in Alarm1 v

Warking Period

Anti-Dither 0 Second (0~100) Sensor Type | NO v

Record

Record Delay 10 Second (10~300)
Relay-out

Alarm Delay 10 Second (10~300)
Send Email

Snapshot

Default || Refresh H Save

Figure 5-37

Parameter

Note

Enable

Check the box to enable relay activation.

Working
Period

® |tis to set the alarm period, it can enable alarm event only in the set time range.

® There are six periods every day for setup and you must check box in front of
each period to enable it.

® Select days (Sunday by default, if select all the week, then it means applying
the setup into the whole week; you can also check the box in front of the day
and make setting for some days separately).

® Click “OK” button after completing setup, go back to motion detect setting page,
click “OK” button to finish working period setup of motion detect

Note: Period setup can be done by dragging mouse while not releasing left mouse.

Anti-Dither

System only memorizes one event during the anti-dither period. The value ranges
from Os to 100s.

Sensor Type

Able to set NC and NO.

Record

System auto activates motion detection channel to record once alarm occurs
(working with motion detection function). Meanwhile users have to set record period
of alarm in “Storage>Schedule” and select auto record in the record control
interface.

Record Delay

System can delay the record for specified time after alarm ended. The value ranges
from 10s to 300s.
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Parameter Note
Relav-out Enable alarm activation function. You need to select alarm output port so that
y system can activate corresponding alarm device when alarm occurs.
System can delay the alarm output for specified time after alarm ended. The value
Alarm Delay
ranges from 10s to 300s.
After this function is enabled, system can send out email to alert you when alarm
Send Email occurs and ends. Users can set his own email address in “Network Setting >
SMTP”.
Snapshot After you enabled snapshot, the system will automatically snapshot if alarm occurs.

Meanwhile you have to set snapshot period of alarm in the “storage>Schedule”.

5.3.6 Abnormity

Abnormity includes No SD Card, Capacity Warning, SD Card Error, Disconnection, IP Conflict and
Unauthorized Access.

Note:

Only device with SD card function has these three statuses: No SD card, capacity warning, and SD card
error.

Device without SD card function does not have the above three statuses. See Figure 5-38.

@lhua
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Camera 5D Card Network lllegal Access

Event Type No SD Card v

Event
> Video Detect

Enable

«# Relay-out

> IVS Analyse

Alarm Delay 10 Second (10~300)
» Temperature Alarm

> Fire Alarm Send Emall

> Alarm

Temperature

Default H Refresh H Save

Storage

System

Information

Figure 5-38
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Camera SD Card Network llegal Access

Event Type SD Card Error v

Enable
> Video Detect

« Relay-out

> VS Analyse

Alarm Delay 10 Second (10~300)
» Temperature Alarm
> Fire Alarm Send Emall
> Marm Default ‘ | Refresh ‘ | Save
Temperature

Storage
System
Information

Figure 5-39
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Camera SD Card Network llegal Access

Network P "

Event Type Capacity Warning v
Event

Enable
» Video Detect

Capacity Limit 10 %(0~-99)
> IVS Analyse

« Relay-out
> Temperature Alarm
» Fire Alarm Alarm Delay 10 Second (10~300)
5 Alarm Send Email
Default H Refresh || Save

Temperature
Storage

System

Information

Figure 5-40
Please refer to the following sheet for detailed information.

Parameter | Function

Three event types to cause SD card abnormity: No SD card, SD card

Event ) /
Type capacity warning, and SD card error.
Enable Check to alarm when SD card is abnormal.
Relay-out Check to enable relay-out alarm.

Relay out | The alarm output can delay for the specified time after alarm stops. The
delay value ranges from 10s to 300s.

Note:

No SD card, capacity warning, SD card error, relay-out delay all start
from alarm occurs.

Send After you enabled this function, the system can send out email to alarm
email the specified user.

This function is invalid when network is offline or IP conflict occurs.
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Parameter | Function

SD Card User can set SD card capacity that is left free. When SD card space left
Capacity | is smaller than this limit, alarm occurs.
Limit

When device is offline or IP conflicts, the abnormal alarm is similar with case of SD card error.

@Jhua
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Network
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> Video Detect
#| Record
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Figure 5-41
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#| Record
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Temperature

Default H Refresh || Save
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System

Information

Figure 5-42

When login password keep been wrong for a few times, unauthorized access alarm occurs. This
operation is similar to SD card error. Allow login error times as when it exceeds this limit, user account
will be locked.
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@hua

Camera SD Card Network lllegal Access

Network Fa—

Login Error 3 time (3~10)
> Video Detect

« Relay-out

> IVS Analyse

Alarm Delay 10 Second (10~300)
> Temperature Alarm
> Fire Alarm Send Emall
> Alam Default ‘ | Refresh | | Save
Temperature

Storage

System

Figure 5-43

5.4 Temperature

Note:
Some models don’t support temperature measurement function.

5.4.1 Rule Setup
5.4.1.1 Parameter Config

ua

TECHNOLOGY

Camera
Network
2015-09-25 18 » Parame Config ¥ Measurement ltems
Event S T @ o~
» Temperature 1: e Spott i
¥ 2 —Line1 i}
S v/ 3: CAreat i}
> Global
> heatmap
Storage
System —— Parameter Setup
Information o 1 | ¥ Open Local Config
Target Radiation Coefficient 0.95
Iin: 1.8
Target Distance 10 m
Target Reflection Temperature | 0 c
Relay-out
Alarm Results Max v
Redraw Rule
Alarm Condition Below v
Alarm Threshold Temperature | 20 e
Temperature Error += 0.1 c
Duration Of Temperature 30 s
Defautt || Reesn || sawe

Figure 5-44

69



aJhua

TECHNOLOGY

Dahua IR Thermal Imaging Network Camera Web3.0 Operation Manual

Parameter Note

Measurement Click to add new spot, line and area, click corresponding I to delete the
ltems measurement item.

Open Local . . .

Config Check it to enable local config function.

Target

Radiation It is to set the target emissivity, 0~1 optional.

Coefficient

Target Distance

It is to set the distance between camera and target, 0~1000m optional.

Target
Reflection It is to set the target temperature, 0~550"Coptional.
Temperature
Relay Out Check it to enable relay out function.
It is to set the temperature value mode of triggering alarm.
e  Spot: optional value
Alarm Result ) ,
e Line: able to select max, min and average.
e Area: able to select max, min, average, standard and middle
Alarm_ . It is to set alarm condition, optional below, match and above
Condition ’ ' ’
Alarm
Threshold It is to set the threshold temperature of triggering alarm, 0~550°C optional.
Temperature
E(;zrrgrperature It is to set temperature error, 0~10"Coptional.
It will trigger alarm when the temperature is above the alarm threshold temperature
Temperature . .
Duration and exceed the set duration temperature. Temperature duration O ~ 1000s
optional.
Redraw Rule Redraw Rule

Click to redraw corresponding rule.

When the temperature of designated spot, line or area meets the condition of triggering alarm, it will
continue to flicker to red as alarm hint in the preview interface. See Figure 4-82.

Note:

It will display alarm result in the preview interface only when check “Enable “in the

“Event >

Temperature Alarm” and set appropriate “Working Period”.

70



@hua

Dahua IR Thermal Imaging Network Camera Web3.0 Operation Manual

Spotl
Ave: 30.8

Line 1

Ave: 31.4 Min: 30.8 Max:

Areal
Ave: 30.9 Min: 30.6 Max

Figure 5-45
5.4.1.2 Temperature Contrast
Note:
The function is only supported by some models.

alhua [TT— ——

Camera

Network

2015:09-25 18:4332 Fri » Parame Config ¥ Temperature Contrast
Event SSkal i

Temp

[ e e

> Global
> heatmap
Storage
System

Default ‘ | Refresh ‘ | Save
Information s 3
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Figure 5-46
Temperature contrast function means comparing the temperature of selected spot, line or area and
display the result on the preview interface, the steps are shown as follows:
Step 1 Click ™7 to add contrast record.
Step 2 Select the target which needs to be compared, see Figure 5-47.

¥ Temperature Contrast

¥ 1: Spot1 ¥ |- Spot2 v

Spot?

Eb

Cefault | | Fefresh | | Save

Figure 5-47

Step 3 Click B o save, then you can see the contrast result of the selected target on the left of

preview interface, see Figure 5-48.

@Jhua

Camera

Network
» Parame Config ¥ Temperature Contrast

Event

B

> Global
> heatmap

Storage

System _ \ Default | | Refresh | | Save
Information . = 2 |

Figure 5-48
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5.4.2 Global
@hua

Camera Global

:::”n‘:rk b 165%% | TempreatureSwitch
~ — Tempreature Unit 'C ¥.
L Relative Humidit =) 0 50
Glooal Atmospheric Temperature (=) O 20
> heatmap Physical Radiation Coefficient (=) O 1
Storage Object Distance -0 100
System Object Reflective Temperature (=) —{} 20
Information ¢/ Hot Spot Follow
High CTMaker Color W 255,0,0,255
Low CTMaker Color MW 0.0,255 255
Isotherm ON * OFF
Win Limit Temperature ® O () 30
Medium Temperature ®—0 36
Max Limit Temperature = O () 37
Saturation Temperature = 0 48
Color Code ® ON OFF
Default | | Refresh | l Save |
Figure 5-49
Parameter Note
;SVTEE rature Check it to enable temperature switch function.

Temperature Unit

It is to set the displayed temperature unit, ‘C and F optional.

Relative Humidity

It is to set the environment relative humidity, 0~100% RH optional.

Atmospheric
Temperature

It is to set environmental temperature, 0~100°C optional.

Physical Radiation
Coefficient

It is to set physical radiation coefficient, 0~1 optional.

Object Distance

It is to set physical distance, 0~100m optional.

Object  reflective
Temperature

It is to set the object reflective temperature, 0~100°C optional.

Hot Spot Follow

Check it to enable the function of hot spot detection tracing.

High CTMaker
Color

It is to set the display color of high temperature.
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Parameter

Note

Low CTMaker
Color

It is to set the display temperature of low temperature.

Isotherm

It is to select if enable isotherm function.

Min Temperature

It is to set min temperature.

® When gain mode is under low temperature mode, it is -40°C ~160°C
optional.

® When gain mode is under high temperature mode, it is -40°C ~600°C
optional.

Medium
temperature

It is to set medium temperature.
® When gain mode is low temperature, it is -40°C~160°C optional.
® When gain mode is high temperature, it is -40°C~600°C optional.

Max Temperature

It is to set max temperature.
® When gain mode is low temperature, it is -40°C~160°C optional.
® \When gain mode is high temperature, itis -40°C ~600°C optional.

It is to saturation temperature.

Saturation ® \When gain mode is low temperature, it is -40°C ~160°C optional.
Temperature

® When gain mode is high temperature, it is -40°C ~600°C optional.
Color Code It is to select if enable color code.

5.4.2.1 Temperature Switch

Temperature switch function is mainly used to realize real-time temperature measurement aiming at
some certain spot and display the temperature on the preview interface. As it is shown in Figure 5-50,
when the mouse moves to one spot, it will display the temperature of the spot.
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Min:25.1

Figure 5-50

5.4.2.2 Hot Spot Follow

After enabling hot spot follow function, it will display max temperature spot and min temperature spot in
the preview interface, and set the corresponding color via “High CTMaker Color” and “Low CTMaker
Color” (see Figure 4-89), it will display corresponding high and low temperature color respectively, see
Figure 5-51.

Hot Spot Follow

High CTMaker Color W rgb(255, 0, 0),255 33
Low CTMaker _RGBA{rgb{EEE-. 0,0),255) | X
Isotherm

Min Limit Tem

Medium Temp

Max Limit Tem

Saturation Te

color Code ® ON () OFF
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Figure 5-51

Max:26. 1

Figure 5-52

5.4.2.3 Isotherm

Isotherm function is mainly used for the highlighted object in the high brightness image, take medium
temperature as the basis, max temperature and min temperature are the floating range, display the area
between max temperature and min temperature with bright color, and other areas will be displayed as
black, gray and white, see Figure 4-93.

Isotherm (O ON (@ OFF

Min Limit Temperature =) E] 26
Medium Temperature (=) D 82
Max Limit Temperature =) O 126
Saturation Temperature (=] O 157

Figure 5-53

Note:
Min temperature <=Medium temperature <= Max temperature <= Saturation temperature
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Figure 5-54

5.4.2.4 Color Code
After checking color code, it will display corresponding color code on the right of the preview interface,
which can be used to present the color change between min temperature and max temperature. See

Figure 5-55.

Min:25.1

Figure 5-55
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5.4.3 Heatmap

@Jhua
Camera heatmap

Network Export heatllap

Event

> Rule

> Global

Storage

System

Information

Figure 5-56

Parameter Note

Export

Heatmap Click it to export heatmap.

5.5 Storage Management

5.5.1 Schedule
Before schedule setup, user must set record mode is auto or manual.

Note:
If record mode in record control is off, then device will not snapshot according to schedule.

5.5.1.1 Record Schedule
Record schedule steps:
Step 1. Click on Record Schedule, see Figure 5-57.

@hua

TECHNOLOGY

Camera Record Schedule

WETES #| General @ ¥ Motion #| Alarm B
Event
0 2 4 [} 8 10 12 14 16 13 20 22 24
Temperature
e *
> Destination IS
> Record Control Wednesday
Information Friday
4
P
e
P
Default H Refresh H Save
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Figure 5-57

Step 2. From Monday to Sunday select record time, click on setup on the right, see Figure 5-58.

® Set period according to actual need. There are six periods available each day.

® By checking or unchecking, you can add or delete three types of record schedule: General, Motion,
and Alarm.

Note:

Period setup can be done by dragging in record schedule interface while not releasing left mouse.

Setup % |
] An Sunday [C] Monday [_| Tuesday [| Wednesday (] Thursday [] Friday [_| Saturday [] Holiday
Period 1: 00 : 00 : 00 |-| 23 : 59 : 59 |[C] General Mation
Period 2: 00 - 00 : 00 | -| 23 : &9 : 89 |[] General [| Motion
Period 3: 00 : 00 : 00 |-| 23 : 59 : 59 |[C] General [C] Motion
Period 4: 00 - 00 : 00 | -| 23 : &9 : 89 |[] General [| Motion
Period 5: 00 : 00 : 00 |-| 23 : 59 : 59 |[C] General [C] Motion
Period 6: 00 - 00 : 00 |-| 23 : 69 : &9 |[C] General [C] Motion
Save H Cancel ‘
Figure 5-58

Step 3. Click on OK, return to record schedule interface. See Figure 5-59.
® Green color stands for the general record/snapshot.

® Yellow color stands for the motion detect record/snapshot.

® Red color stands for the alarm record/snapshot.

alhua

- TECHNOLOGY

Camera Record Schedule Snapshot Schedule Holiday Schedule

Network
#| General @ [# Motion v Alarm B
Event
0 2 4 6 3 10 12 14 16 13 20 22 24
Temperature N
Schedule ' v —
> Destination T
> Record Control \Wednesday
Information Friday
P
e
Default ‘ | Refresh | ‘ Save
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Step 4. In record schedule interface, click on OK. System prompts it is successfully saved.

5.5.1.2 Snapshot Schedule
Snapshot setup as:
Step 1. Click on Snapshot Schedule tab, see Figure .

hua

~ TECHNOLOGY

Camera Record Schedule

L= « General @ ¢ Motion < Alarm B
Event
0 2 4 B 8 10 12 14 18 18 20 22 24
Temperature
Schedule

> Destination TLEEGE
> Record Control Wednesday
Information Friday

e

Default H Refresh H Save

Step 2. From Monday to Sunday select snapshot time, click on setup on the right. See Figure 5-61.

® Set snapshot period according to actual need. There are six periods available each day.

® By checking or unchecking, user can add or delete three types of snapshot schedule: General,
Motion and Alarm.

Note: Period setup can be done by dragging in snapshot schedule interface while not releasing left

mouse.

Setup X |
1 An Sunday [T] Monday [] Tuesday [] Wednesday [] Thursday [T] Friday [] Saturday [_| Holiday
Period 1: 00 : 00 : 00 |- 23 : B9 : 59 General Motion
Period 2: 00 : 00 : 00 |- 23 : &9 : 59 |[| General []| Motion
Period 3: 00 - 00 : 00 |-| 23 : 59 : 59 |[C] General [C] Motion
Period 4: 00 : 00 : 00 |- 23 : B9 : RO |[] General [C] Motion
Period 5 00 : 00 : 00 |-| 23 : 89 : 59 |[C] General [T] Motion
Period 6 00 : 00 : 00 |-| 23 : 89 : 59 |[C] General [T] Motion
| Save || Cancel |
Figure 5-61
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Step 3. Click on OK, return to snapshot schedule interface. See Figure 5-62.
® Green color stands for the general record/snapshot.

® Yellow color stands for the motion detect record/snapshot.

® Red color stands for the alarm record/snapshot.

@

Camera Record Schedule
Network

#| General @ |« Motion « Alarm W

Event

Temperature (TTTTTTT]

Sunday
LT TTTTT

_ Wonday
o [LTTTTTT1

> Destination Tuesday
[LTTTTTT

> Record Control Wednesday
System Thursday | 1T}
Information Friday IS

Saturday | L LU T TTT]

Holiday

Figure 5-62

Step 5. In snapshot interface, click on OK. System prompts it is successfully saved.

5.5.1.3 Holiday Schedule
Holiday schedule can set specific date as holiday.
Step 1. Click on Holiday Schedule tab, see Figure 5-63.

[ E]

~ TECHNOLOGY

Camera Record Schedule Snapshot Schedule | Holiday Schedule

Network
etworl # Record ¥ Snapshat

Calendar

Event

Temperature
Sun Mon Tue Wed Thu Fri Sat

> Destination E E’
> Record Control
System
Information
‘ Refresh H Save |

Figure 5-63
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Step 2. Select date to set as holiday. The selected date will be highlighted in yellow.

Step 3. Check Record/Snapshot, click on Save. System prompts it is successfully saved.

Step 4. Check Record Schedule/Snapshot Schedule interface, click on setup next to Holiday, refer to
setup of Monday to Sunday.

Step 5. Complete setup of holiday, then it records/snapshots according to date in holiday schedule.

5.5.2 Destination

5.5.2.1 Path

The destination interface is shown as in Figure 5-64.

Path can config record and snapshot storage path. There are three options: Local, FTP and NAS. You
can only select one mode. System can save according to the event types. It is corresponding to the
three modes (general/motion/alarm) in the Schedule interface. Please check the box to enable the save
functions.

Note: Only device supports SD card has local.

@lhua

Camera Path
Network

Record Snapshot

Esant Event Type Scheduled Motion Detect Alarm Event Type Scheduled Motion Detect Alarm
Temperature Local v v < Local 7 o L
Storage FTP FTF

> Schedule

> Record Control |

MAS MAS

Default || Refresh H Save

System

Information

Figure 5-64
Please refer to the following sheet for detailed information.
Parameter | Function
Event It includes: scheduled, motion detect and alarm.
Type
Local It saved in the SD card.
FTP It saved in the FTP server.
NAS It saved in NAS disk.
5.5.2.2 Local

The local interface is shown as in Figure 5-65.
Here you can view local Micro SD card or NAS disk information. You can also operate the read-only,
write-only, hot swap and format operation.

82



avec!a'oya Dahua IR Thermal Imaging Network Camera Web3.0 Operation Manual

@

Camera

Network
Event

Temperature

> Schedule

> Record Control

System

Information

Read Only | ‘ Read & Write | ‘ Hot Swap | ‘ Refresh

Figure 5-65

5523 FTP

The FTP interface is shown as in Figure 5-66.

You need to check the box to enable the FTP function. When network disconnect occurred or there is
malfunction. Emergency storage can save the record/snapshot picture to the local SD card.

@lhua

Camera Path
Network e

Event

Server Address

Temperature

Port 21 (0~65535)

User Name ananymit
> Schedule ymity

> Record Control

Password
Remote Directory share

System Emergency (Local)

Information ‘ |

Default Refresh || Save

Figure 5-66

5.5.2.4 NAS

You need to check the box to enable the NAS function. Select NAS storage, fill in NAS server
address and corresponding store path, then you can store video file or pictorial information in the NAS
server.

Select NAS storage as to same file to NAS disk. See Figure 5-67.
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@hua

TECHNOLOGY

Camera Path
Network
Event

Enable

8erver Address

Temperature
Remote Directory

> Schedule Default ‘ | Refresh ‘ | Save

¥ Record Control

System

Information

Figure 5-67

Parameter Function

Server Address | Set IP address of NAS server.

Remote Set storage directory, videos and pictures can be stored in to corresponding server
Directory directory.

5.5.3 Record control
The record control interface is shown as in Figure 5-68.

@lhua

TECHNOLOGY

Camera Record Control
Network
Event

Pack Duration 30 Minutes (1~120)

Pre-event Record ) Second (0~5)

Temperature
Disk Full Overwrite A

Record Mode * Auto Wanual off
> Schedule

> Destination Record Stream Main Stream v

Record Control

System

Default H Reifresh H Save

Information

Figure 5-68

Please refer to the following sheet for detailed information.

Parameter Function

Pack Here you can select file size within 1min~120min. Default setup is 8
minutes.

Duration
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Pre-record | Please input pre-record value here.

For example, system can record the four seconds video in the buffer.
The record begins from the fifth second.

Note:

Configure pre-record time, when alarm or motion detection occurs, if
there is no record, system will record the preceding n seconds
record.

Disk Full There are two options: stop recording or overwrite the previous files

when HDD is full.

® Stop: Current working HDD is overwriting or current HDD is full,
it will stop record.

® Overwrite: Current working HDD is full; it will overwrite the
previous file.

There are three modes: Auto/manual/close.

Record
mode

Record There are two options: main stream and sub stream.

stream

5.6 System

5.6.1 General
The General interface is shown as in Figure 5-69. .

@hua

INOLOGY

Camera General Date&Time

Network Device Name 2015 07_15 09

Event

Language English
Temperature

Video Standard PAL
Storage

System Default ‘ | Refresh | ‘ Save

> Account

> Default

> Impori/Export
> Auto Maintain
> Upgrade

Information

Figure 5-69

Please refer to the following sheet for detailed information.

Parameter Function

It is to set device name.
Note: Different devices have different names.

Device
Name

85



@hua

Dahua IR Thermal Imaging Network Camera Web3.0 Operation Manual

Video
Standard

This is to display video standard such as PAL.

Language You can select the language from the dropdown list.

The date and time interface is shown as in Figure 5-70.

@Jhua

Camera
Network

Event
Temperature
Storage
System

General

> Account
> Default
> Impori/Export
> Auto Maintain

¥» Upgrade

Information

Date&Time

General

Date Format Year-Month-Day v

Time Format 24-Hour-based System ¥

Time Zone GMT+08:00 v

Current Time 2015 - 09 - 25 |13 40 . 21
DST Enable

DST Type ® Date Week

Start Time Jan v|1 v 00 @00 00

End Time Jan V|2 v, 00 @00 00

Synchronize with NTP

NTP Server clock.isc.org
Port 123
Update Period 10 Minutes (0~30)
Detaut || Remesn || sawe

Figure 5-70
Please refer to the following sheet for detailed information.

Parameter | Function

Date format | Here you can select date format from the dropdown list.

Time There are two options: 24-H and 12-H.

Format

Time zone | The time zone of the device.

System It is to set system time. It becomes valid after you set.

time

Sync PC You can click this button to save the system time as your PC current
time.

DST Here you can set day night save time begin time and end time. You
can set according to the date format or according to the week
format.

NTP You can check the box to enable NTP function.
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NTP server | You can set the time server address.

Port It is to set the time server port.

Update It is to set the sync periods between the device and the time server.
period

5.6.2 Account
® For the character in the following user name or the user group name, system max supports 15-

digits. The valid string includes: character, number, and underline.

® Password can be 0~32 characters in number and letter only. User can modify other user’s
password.

® The user amount is 18 and the group amount is 8 when the device is shipped out of the factory.
The factory default setup includes two levels: user and admin. You can set the corresponding group
and then set the rights for the respective user in the specified groups.

® User management adopts group/user modes. The user name and the group name shall be unique.
One user shall be included in only one group.

® Currently logged in user cannot change his/her own right.

)

5.6.2.1 Username

In this interface you can enable anonymity login, add/remove user and modify user name. See Figure 5-

71.

@Jhua

NOLOGY

Camera Account

Network

Anonymaous Login

Event
User Name Group

No. User Name Group Name Remark ‘Modify Delete
Storage 1 admin admin admin ‘s account L =

Temperature

> General

> Default

» Import/Export
> Auto Maintain

» Upgrade

Information Authority List
Live Playback Record Control Backup Account Alarm
Log Search ClearLog Upgrade Auto Maintain General Video/Audio
Schedule/Destination Metwork Abnormality Video Detect Defaultimport/Export Conditions
Temperature Config Report Config Temperature Correct Fire Warning s
Figure 5-71
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Enable anonymity login: Enable anonymity login, and input IP. No username or password is required,
you can log in by anonymity (with limited rights). You can click logout to end your session.

Add user: Itis to add a name to group and set the user rights. See Figure 5-72
There are four default users: admin/888888/666666 and hidden user “default’. Except user 6666, other
users have administrator right. The user 666666 can only have the monitor rights,.

Hidden user “default” is for system interior use only and cannot be deleted. When there is no login user,
hidden user “default” automatically login. You can set some rights such as monitor for this user so that
you can view some channel view without login.

Here you can input the user name and password and then select one group for current user.
Please note the user rights shall not exceed the group right setup.
For convenient setup, please make sure the general user has the lower rights setup than the admin.

Add User x|

User Mame

Password

Passwaord Strenath Strong
Confirm Password

roup admin v
Remark

Authority List All

Live
Flayback

Record Control

& & & &%

Backup -

Save | | Cancel

Figure 5-72

Modify user

It is to modify the user property, belonging group, password and rights. See Figure 5-73.

Modify password

It is to modify the user password. You need to input the old password and then input the new password
twice to confirm the new setup. Please click the OK button to save.
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Please note, the password ranges from 0-digit to 32-digit. It shall include the number and letter only. For
the user who has the account rights, he can modify the password of other users.

Modify User

User Name

[C] Modify Password

admin E2

%]

Group
Remark
Authority List All
Live :
(=1
Playback
Record Contral
Backup -
Save | | Cancel
Figure 5-73

The group management interface can add/remove group, modify group password and etc.
The interface is shown as in Figure 5-73.

@lhua

Camera
Network
Event
Temperature

Storage

> General
> Default
» Impori/Export
> Auto Maintain
> Upgrade

Information

Account

Anonymous Login

User Name

1 admin administrator group @
2 user user group @

Authority List

Live Playback Record Control Backup Account Alarm

Log Search ClearLog Upgrade Auto Maintain General Video/Audio

Schedule/Destination Metwork Abnormality Video Detect DefaulimportExport Conditions

Temperature Config Report Config Temperature Correct Fire Warning s

Add Group
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Add group: Itis to add group and set its corresponding rights. See Figure 5-74.
Please input the group name and then check the box to select the corresponding rights. It includes:

preview, playback, record control, PTZ control and etc.

Add Group % |
Group
Remark
Authority List ] A
[] Live m
] Playback
[ Record Control
[ Backup -
Save || Cancel
Figure 5-74

Modify group
Click the modify group button, you can see an interface is shown as in Figure 5-75.

Here you can modify group information such as remarks and rights.

Modify Group % |
Group admin |E|
Remark administrator group
Authority List All
Live m

Playback
Record Control

Backup -

Save | | Cancel

Figure 5-75
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5.6.3 Default

The default setup interface is shown as in Figure 5-76.

Please note system cannot restore some information such as network IP address.
@lhua

Camera Default
Network

Event Default

Temperature

Storage

> General
> Account
» Import/Export
> Auto Maintain
> Upgrade

Information

Figure 5-76

5.6.4 Import/Export
The interface is shown as in Figure 5-77.

@lhua

Camera Import/Export

LELET Backup Path

Event

Temperature Impart H Export

Storage

> General
> Account
> Default

ImportiExport

> Auto Maintain

> Upgrade

Information

Figure 5-77

Please refer to the following sheet for detailed information.

Parameter | Function
It is to import the local setup files to the system.

Import

It is to export the corresponding system setup to your local PC.

Export

5.6.5 Auto Maintenance

The auto maintenance interface is shown as in Figure 5-78.
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Here you can select auto reboot and auto delete old files interval from the dropdown list.
If you want to use the auto delete old files function, you need to set the file period.

@hua

INOLOGY

Camera Auto Maintain
Network

Event

#| Auto Reboot Tuesday

Auto Delete Old Files

Temperature

Storage Manual Reboot

System

Refresh | ‘ Save

> General
> Account
> Default
> Import/Export
> Upgrade

Information

Figure 5-78

Parameter Function

Auto Reboot Check it and set auto reboot time.

Auto Delete Old

Files Check it and set period within 1~31 days.

5.6.6 Upgrade
The upgrade interface is shown as in Figure 5-79.
Please select the upgrade file (file extension is “.bin”) and then click the update button to begin firmware

update.

Important
Improper upgrade program may result in device malfunction!

@lhua

Camera Upgrade

[ Select Firmware File Upgrade

Event
Temperature

Storage

System

> General
> Account
> Default
> Import/Export
> Auto Maintain

Upgrade

Information

Figure 5-79
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5.7 Information

5.7.1 Version
The version interface is shown as in Figure 5-80.
Here you can view system hardware features, software version, release date and etc. Please note the

following information is for reference only.

@lhua

Camera Version

Network

Device Type TPC-BFS600A-T

Event
Software Version 2.400.0000.1 R, build - 2015-08-23

Temperature

WEB Version 3.2.1.296855
Storage

ONVIF Version 241
System

FLIR Version E3.00.05

SiN 20:15:07:14:15:09

Version

> Log
Copyright 2015 All Rights Reserved

> Online User

Figure 5-80

5.7.2 Log
Here you can view system log. See Figure 5-81.

@hua

TECHNOLOGY

Camera Log
Network

StartTime | 2015 - 09 - 24 19 @ 85 44 EndTime | 2015 - 09 - 25 19 © 85 @ 44
LEaEEE Ho. Log Time User Name Event

Storage

System

> Version
Log

> Online User

Detailed Information

M 411 P McaTo (=)

Figure 5-81

Please refer to the following sheet for log parameter information.
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Parameter | Function

Start time Set the start time of the requested log. (The earliest time is 2000/1/1)

End time Set the end time of the requested log. (The latest time is 2037/12/31)

Type Log type.

Search You can select log type from the drop down list and then click search
button to view the list.
You can click the stop button to terminate current search operation.

Log You can select one item to view the detailed information.

information

Clear You can click this button to delete all displayed log files. Please note
system does not support clear by type.

Backup You can click this button to backup log files to current PC.

5.7.3 Online User

The online user interface is shown as in Figure 5-82.
Here you can view current online user, group name, IP address and login time.

@lhua

Camera Online User

Network
Event 1
Temperature
Storage

System

> Version

> Log

Online User

User Login Time

IP Address
admin admin 10156145 2015-09-25 18:12:42

Figure 5-82
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6 Alarm

Please note some series product does not support this function.
Click alarm function, you can see an interface is shown as in Figure 6-1.
Here you can set device alarm type and alarm sound setup.

@lhua
Alarm Type HNo. Time Alarm Type Alarm Channel
Motion Detect Disk Full
Disk Error External Alarm
lllegal Access V3
Temperature Alarm Fire Alarm
Operation
Prompt
Alarm Tone
Play Alarm Tone
Tone Path
Figure 6-1
Please refer to the following sheet for detailed information.
Type Parameter Function
Alarm Motion detection | System alarms when motion detection alarm
type occurs,
Disk full System alarms when disk is full.
HDD System generates an alarm when HDD is
malfunction malfunction.
External alarm Alarm input device sends out alarm.
Unauthorized System alarms when there is unauthorized access.
Access
IVS Check it, and the system generates alarm when it

meets the condition of IVS.
Note: only some models support the function.

Temperature Check it, and the system generates alarm when

Alarm the temperature meets some certain threshold.
Note: only some models support the function.

Fire Alarm Check it, and the system generates alarm when it

meets the threshold of fire alarm.
Note: only some models support the function.
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Type

Parameter

Function

Operation

Prompt

.|

When alarm is triggered, there will be s /|
inmain menu of alarm interface and system
automatically records alarm info. The icon
disappears when user click on alarm menu bar.
Note:

If alarm interface is displayed, when alarm is
triggered, there will be no image prompt, but alarm
record will be in list on the right.

Alarm
audio

Audio

When alarm occurs, system auto generates alarm
audio. The audio supports customized setup.

Path

Here you can specify alarm sound file.
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7 Log out

Click log out button, system goes back to log in interface. See Figure 7-1.

aJhua

TECHNOLOGY

Username: | admin

Password:

Login ” Cancel

Figure 7-1
Note:
® This manual is for reference only. Slight difference may be found in user interface.
® All the designs and software here are subject to change without prior written notice.
® All trademarks and registered trademarks mentioned are the properties of their respective
owners.
® If there is any uncertainty or controversy, please refer to the final explanation of us.
® Please visit our website for more information.
@hua

Dahua Technology Co., Ltd

Address: No0.1199 Bin’an Road, Binjiang District, Hangzhou, PRC.
Postcode: 310053

Tel: +86-571-87688883

Fax: +86-571-87688815

Email:overseas@dahuatech.com

Website: www.dahuatech.com
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